
 

IMNE790567_CH2_FEV_CL0_AS_C_0001 Page i  

 
Using this 
template  

The standard headings and tables in this template should be modified to meet the 
requirements of each Initial Assessment.  The sites may have diverse issues and 
constraints and problems and the standard template is therefore just a guide on 
typical requirements but flexibility is allowed to amend/ add headings as required 

 
 Hidden 
guidance  

The template contains various pieces of guidance covering content, use of tables 
etc.  The guidance is shown in blue text and can be turned ‘on’ to assist in the 
writing stages or ‘hidden’ for viewing or when printing the document.  You can 
switch between ‘hidden’ and ‘on’ and back to ‘hidden’ at any time. 

To show/hide the guidance click on the ¶ icon on the MS Word toolbar.  

If the hidden text does not disappear off the screen when the ¶ icon is clicked, go 
to:  Tools>Options>View Tab and uncheck the ‘Hidden text’ box.   

It is advisable to work with the hidden text turned on, as this helps to format new 
text and to avoid deleting the hidden text itself. 

 
Inserting new 
headings  

To insert new headings in the main text go to: Format>Styles and Formatting to 
open the styles box. Insert the new headings, highlight it and click on the 
appropriate Heading level in the ‘Pick formatting to apply’ box.  Paragraph text 
can be inserted and formatted in a similar way. 

 
Inserting new 
tables  

Table labels should be added by Insert>Reference>Caption and selecting ‘Table’ 
from the drop down ‘Label’ box.  This will insert the Table title with the correct 
number and the caption can be typed in after the label.  Tables can then be cross 
referenced from the text by Insert>Reference>Cross Reference and selecting the 
appropriate reference type and caption from the drop down box and list. 

 
Numbering 
paragraphs  

All paragraphs should be numbered sequentially as sub-sets of the section 
number. Prompts for paragraph numbering are provided as ‘Start writing here’ 
after which pressing <return> will automatically provide the next paragraph 
number.  
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1.1  Introduction and background 

1.1.1 Description of Location 

Castlefields Lane is a road in the town of Bingley within the Bradford Metropolitan District 
close to Castlefield Industrial Estate. The lower extent of this road is located alongside the 
River Aire. The study area incorporates the low-lying area of this road and the industrial 
estate, both of which are at risk of flooding from the left bank of the River Aire. The area 
experienced severe flooding during December 2015. 

The study area falls under the Aire CFMP1, and is covered by sub-area 3 Worth and Aire. The 
designated policy for the area at risk is Policy Option 5: Areas of moderate to high flood risk 
where we can generally take further action to reduce flood risk. 

There are no previous studies for this area. The site has been identified for appraisal based on 
the impacts of the December 2015 flooding. 

According to the Index of Multiple Deprivation (IMD), the area is amongst the 40 to 50% least 
deprived neighbourhoods in the country.  

 

                                                
 
1 River Aire Catchment Flood Management Plan - https://www.gov.uk/government/publications/river-aire-
catchment-flood-management-plan 
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Figure 1: Castlefields Lane site location 
1.1.2 Description of Watercourses and Geology 

The River Aire is a major river in Yorkshire flowing from Malham in the Yorkshire Dales, 
through the urban areas of Bradford and Leeds, before joining the River Ouse at Airmyn. The 
Aire is approximately 71 miles in length from its source to its confluence. 

The Upper Aire around Bradford is heavily urbanised and the floodplain is constrained by 
development. There are a number of tributaries within this area that respond rapidly to rainfall. 
There is also a large number of structures such as bridges in this area.  

1.1.3 History of Flooding 

The properties in the study area have been flooded several times in recent years. During the 
2015 Boxing Day flood incident properties were flooded when high river levels in the River Aire 
caused the river to overtop its banks. Properties close to the river were flooded to a depth of 
1.5m. This area was also flooded from the river in 2000, 2002 and 2012.  

The Boxing Day 2015 flood incident was the largest flood event recorded across the Upper 
Aire. The return period of this event was estimated to be between 80 and 100 years (1.25%-
1% AEP) at Kildwick in the Upper Aire and was higher further downstream with a return period 
of 200 years (0.5% AEP) at Armley. 

There are also issues with surface water and ground water in the area with properties at low 
points reporting flooding from these sources. 

1.1.4 Summary of Modelling Analysis 

In 2008 hydraulic and hydrological modelling of the Upper River Aire was completed by JBA to 
support the development of the Flood Risk Management Strategy. For this study the River Aire 
was modelled from High Hill Weir upstream of Gargrave to Fleet Weir downstream of Leeds. 
The Upper River Aire model is a 1D hydrodynamic ISIS model containing 1922 nodes. 

The 2008 modelling study aimed to define flood risk within this area and identify potential flood 
risk management options. This informed the Flood Risk Management Strategy for the Upper 
Aire. This strategy recommended local flood risk management schemes where there is a 
justification for this and identified a number of sites that should be progressed. Castlefields 
Lane was not identified as a priority site in this report. 
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1.1.5 Drivers, Constraints, Opportunities 
The following drivers, constraints and opportunities have been identified within the study area. 
Refer to Appendix B for the full list of constraints that were considered. 

Political Drivers  Summary Description 

Catchment Flood Management Plan River Aire Catchment Flood Management Plan 2010 

Catchment Flood Management Policy 

Policy 5 – Areas of moderate to high flood risk where 

we can generally take further action to reduce flood 

risk. 

Economic Drivers   Summary Description 

Funding Time Constraints 

Must be obtained within 6 year programme of 

capital investment 

Technological Drivers  Summary Description 

Improved Public Safety Via reduced flood risk 

Environmental Constraints  Summary Description 

Special Area of Conservation (SAC) South Pennine Moors 1.7km north east of study area 

Listed Buildings 5 listed buildings along riverbank in area at risk 

SSSI 

Bingley South Bog SSSI 2km southeast of study area, 

South Pennine Moors 1.7km north east 

Ancient Woodland 

Blakey Wood 0.1 kilometre to the south west from 

the site 

1.2 Problem and objectives 

1.2.1 Problem 

The site is at risk of fluvial flooding due to its proximity to the River Aire. The river bank at 
Castlefields Lane is low and close to properties. As such there is a risk of flooding from 
relatively small increases in river level. 

There are 10 residential properties on Castlefields Lane, and 20 non-residential properties 
within Castlefield Industrial Estate thought to be at risk from a 1 in 25 (4%) flood incident and a 
further 2 residential properties on Castlefields Lane, and a further 6 commercial properties on 
the adjacent industrial estate at risk from a 1 in 200 (0.5%) flood incident.  

Work is currently ongoing to determine the standard of protection provided by the riverbank at 
this location. 

There are no flood defences in this location. Flood risk is currently managed through 
maintenance of the river channel, particularly by managing gravel build-up. Following the 
December 2015 flooding, a gravel shoal has been removed from the river adjacent to 
Castlefields Lane.  

Properties are also at risk from surface water flooding due to the steep slope toward the river 
and the combined sewer that discharges into the river. In addition to this, there is thought to be 
a risk to properties from groundwater flooding. 
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1.2.2 Objectives 

The primary objective of this initial assessment is to undertake a scoping study to identify the 
flood risk issues and viable solutions for the affected properties and to identify any other 
potential flood risk management measures which are consistent with the current CFMP policy.  

The purpose of this report is to lay the groundwork and, where applicable, provide a business 
case for future more detailed appraisal. The report aims to achieve the following: 

• Confirm the need for a project; 

• Identify the issues and Political, Environmental, Societal, Technological, Legislative 
and Economic (PESTLE) drivers and opportunities related to the need; 

• Identify the options to address the need and problem; 

• Demonstrate that viable options exist based upon the available information; 

• Provide sufficient information to allow the packaging and optimisation of packages of 
future appraisal, design and construction packages; 

• Provide sufficient information for the appraisal scope to be prepared; 

• Make an assessment on the deliverability of the project; 

• Provide a basis/starting point for discussion with communities and partner 
organisations for use in the development of potential schemes and negotiations 
regarding funding contributions. 

1.3 Benefits 

In this area the primary benefit associated with a reduction in flood risk would be the reduction 
in economic damages to properties. This in turn would reduce disruption to local transport, 
businesses, schools and other infrastructure. 

The properties at risk consist of residential properties on Castlefields Lane and commercial 
properties within the adjacent Castlefield Industrial Estate. There are no significant public 
buildings within the study area. 

Social benefits relate primarily to a reduction in stress, health effects (including risk to life) and 
loss of memorabilia for those at risk. 

An appraisal period of 100 years is assumed, over which the current Standard of Protection of 
existing assets is expected to decrease as a result of climate change. 

In order to quantify the benefits of a scheme the 2008 modelled flood outlines were used to 
estimate the properties currently located within each risk band. Properties within the 1 in 25 
year outline were assessed as being in the Very Significant risk band as there is no 1 in 20 
year outline available. Properties within the 1 in 75 year outline were assessed as being in the 
Significant Risk band and Properties within the 1 in 200 year outline were assessed as being 
in the Moderate Risk band. 
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Table 1.1 Number of Properties at Risk (based on current outlines) 

Property Type Flood Risk Number of 
Properties 

≥1 in 20 year (5% AEP) 
(Very Significant Risk) 

10 

<1 in 20 year (5% AEP) 
≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

0 Residential  

<1 in 75 year (1.33% AEP)  
≥1 in 200 year (0.5% AEP) 
(Moderate Risk) 

2 

≥1 in 20 year (5% AEP) 
(Very Significant Risk) 

20 

<1 in 20 year (5% AEP) 
≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

1 Non-Residential 

<1 in 75 year (1.33% AEP) 
≥1 in 200 year (0.5% AEP) 
(Moderate Risk) 

5 

1.4 Options 

A long list of options has been compiled for the study area and is summarised in the table on 
the following pages. The table shows the range of options considered and the reasoning for or 
against them being taken forward to the shortlist of options to be assessed.  
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Category Long List 
Option 

Description Take Forward 
for 

assessment? 

Reasoning / Notes / Past Study Reference 

Do nothing Do nothing All operational and maintenance 
activities cease 

Yes Required to support development of business case and 
benefit cost ratios. 

Do minimum Do Minimum Continue with current operational 
and maintenance activities.  

Yes Required to support development of business case and 
incremental b/c ratio. 

Non-structural 
(by EA) 

Improved flood 
warning 

Enhanced flood warning to allow 
residents to prepare plus appropriate 
implementation of flood action plans 

No Not funded via the capital programme.  
A Flood warning system is already in place for the River 
Aire at Crossflatts.   
Improving the current system would require further 
modelling which is beyond the scope of this study. 

Non-structural 
(by EA) 

Flood action 
plans 

Improved direction of reactionary 
flood defence measure (fire crews, 
temporary pumps, etc.) 

No The study area is already within a Flood Warning and 
Flood Alert area operated by the Environment Agency. 

Property level 
protection 

Property level 
protection 

Protection to individual properties 
(e.g. via air brick covers, door guards 
etc).  

Yes This may be viable given the high risk and relatively 
small number of properties. Several properties in the 
area already have a degree of property-level protection. 
This option could also reduce the risk of surface water 
flooding. 
This would not have been effective for the depths of   
flooding experienced in December 2015. 

Urban 
drainage 

Improve urban 
drainage. 

Improved surface water drainage 
system. 

Yes The area has been identified as being at risk of surface 
water flooding. This occurs during relatively minor 
incidents. 
Raising the level of the surface water drainage outfall in 
the area will allow this system to drain during high river 
levels. This will reduce the risk of surface water flooding. 

Structural Flood walls Flood walls Yes Construction of a defence wall along the riverbank at 
Castlefields Lane will raise the standard of protection 
from fluvial flooding for properties in this area. 
Two Alignments for walls are considered, one focuses on 
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Category Long List 
Option 

Description Take Forward 
for 

assessment? 

Reasoning / Notes / Past Study Reference 

the residential properties at Castlefields Lane, the other 
defends this area and the adjacent Castlefield industrial 
estate 

Structural Conveyance Channel deepening or widening No There is no available space for widening the river 
channel.  
The EA currently undertakes gravel removal from the 
channel at this location to maintain conveyance. 

Structural Conveyance Supplementary bypass channel(s), 
tunnels or floodway 

Yes There is a historical mill race within the study area, this is 
currently blocked and disused. This channel could be 
reinstated to act as a flood relief channel. This would 
reduce flood risk but will not be effective in larger events. 

Structural Conveyance River restoration and/or pinch point 
improvements (bridges, culverts and 
weirs) 

No There are no significant pinch points nearby contributing 
to flood risk. 

Flood storage 
area  

Online Use of active structures and re-
profiling to store water online.  

Yes The Upper Aire SFRA considered 2 online storage areas 
at Keighley Holden Park and Marley Bridge. These are 
upstream of Castlefields Lane and would reduce flood 
levels in the study area. 
These areas are being investigated for their benefits to 
Leeds City Centre as part of phase 2 of the Leeds FAS. 
This storage would also have benefits across the River 
Aire including the properties at risk at Castlefields Lane. 

Flood storage 
area 

Offline Gravity or pumping to offline storage 
area 

No No offline storage sites have been identified. 
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1.4.1 Shortlisted Options Description 
 
On-line Storage on River Aire 

The modelling carried out to support the Upper Aire SFRA tested a number of on-line flood 
storage areas (FSA). Two of these were found to lead to significant reductions in flood risk. 
These sites are at Keighley Holden Park and Marley Bridge. Holden Park is the larger of these 
sites.  

Both these storage sites are upstream of the Castlefields Lane study area. As such these sites 
would reduce flood risk at Castlefields Lane. The Marley Bridge FSA site is immediately 
upstream of Castlefields Lane on the north side of the A650.  

These two FSAs were tested for a 1 in 100 (1%) AEP flood incident and were estimated to 
reduce flood levels by 0.89m at Castlefields Lane. There are also benefits across the River 
Aire downstream with an estimated reduction in flood levels of 0.43m in Leeds City Centre.  

As the FSAs considered are active structures these would only provide a benefit when 
operated. This may not be the case in minor flood incidents. The current standard of protection 
at Castlefields Lane is low with 30 properties at risk of flooding from a 1 in 25 (4%) AEP flood 
incident. The FSAs may not protect against these lower return period flood events. 

These FSAs have been considered primarily for their benefit in reducing risk to Leeds City 
Centre and are to be assessed as part of the modelling work for phase 2 of the Leeds FAS. 
However they will provide benefits to areas along the River Aire downstream of the FSA. 

This initial assessment considers the Castlefields Lane area. Whilst the FSA upstream of here 
would reduce risk to Castlefields Lane it will have significant benefits beyond the study area. 
As such assessing the benefits and costs of this option are considered to be outside of the 
scope of this study, and therefore the option has not been taken forward for further 
assessment.
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Figure 2: Approximate location of potential storage  sites on River Aire 
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The following options were chosen to be taken forward for assessment in conjunction with the EA 
and Bradford Metropolitan District Council (MDC).  
 
Do Nothing  

The Do Nothing option is defined as taking no action whatsoever; under this option all 
management activities would cease, including maintenance and repair work. 

Under this assumption, the natural deterioration of the channel would occur, leading to 
reduced conveyance and increased flooding. 

The Do Nothing option is not to be taken forward as a viable option as it results in an 
unacceptable increase in flood risk to people and property due to failure and deterioration of 
assets. However, it needs to be considered as a baseline in order to measure the benefits of 
other options. 

Do Minimum 

The Do Minimum option is normally defined as the minimum level of action or intervention 
necessary to continue to maintain the existing flood management approach whilst it is 
sustainable to do so.  It does not allow for any capital works and forms an alternative appraisal 
baseline to Do Nothing.  

This option assumes continuation of the existing maintenance regime. For this site this will 
include channel maintenance and management of gravel build-up. This also maintains existing 
non-structural measures such as flood forecasting and flood warning. This site is within the 
Crossflatts flood warning area. 

The advantage of Do Minimum is that it continues current flood risk management practice 
within the study area and there is no increase in costs associated with this option. 

The disadvantages of Do Minimum is that the current maintenance regime is not believed to 
significantly reduce the flood risk to people and properties in the study area. The properties 
within the study area are at risk of flooding from relatively common events and a further 
solution would therefore be required in order to reduce the effects of this.  

There are no indicators to suggest that this option is non-viable or undeliverable.   

Option 1 - Flood Walls along River Aire for Castlef ields Lane properties 

Construct flood walls to raise the level of the riverbank at the properties at risk of flooding. 

The Standard of Protection offered by these flood walls is assumed to be 1 in 100 (1%) AEP 
throughout the appraisal period including the effects of climate change. As such the initial 
standard of protection would be expected to be greater than 1 in 100. The alignment of the 
walls and their dimensions are a rough estimate. If this option is taken forward, they will have 
to be assessed and optimised at that stage. The design of the flood walls must be made to fit 
visually in to the surrounding area. 

This option is a permanent structural solution and does not require operation during a flood. 
Floodgates may be required to maintain access through the defence wall, these would 
therefore require closing prior to a flood incident. This will move 10 residential and 7 
commercial properties at Castlefields Lane at significant or very significant risk to the 
moderate risk band. 

Further modelling would be required in order to assess the impact of removal of flood plain 
due to the construction of this flood wall on communities further downstream. Compensatory 
flood plain storage may be required, adding to the costs of the scheme. It must be ensured 
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that the compensatory storage is hydraulically linked to the flood plain lost, otherwise the 
benefits from it may not be fully realised.  

There may be aesthetic challenges to the scheme due to the close proximity of the walls to 
many properties. Views of the river, in particular from properties, would be adversely impacted 
as would access to the river for maintenance purposes. There are no environmental benefits 
to the scheme. Construction of the wall has the potential to cause temporary disruption to 
roads and properties.  

More detailed assessment of this option would need to investigate the area and ground 
conditions to assess the technical challenges with constructing a wall at this location. This wall 
would need to be close to the river and close to properties with a limited working area 
available. Hydraulic modelling would also be required to determine the height of wall that 
would be required to provide the required standard of protection. 

Option 2 - Direct Defences around Industrial Estate  and Castlefields Lane properties 

Construct flood walls and embankments around Castlefield Industrial Estate  

This option is similar to Option 1 but constructs a longer length of defences to defend a larger 
area. Castlefield Industrial Estate is protected in addition to the properties on Castlefields 
Lane. Closer to the industrial estate there is sufficient space available to construct an 
embankment in place of a defence wall. 

This will protect the commercial properties in the industrial estate in addition to the residential 
properties defended by Option 1. The advantages and limitations of this are similar to Option 
1. 

The Standard of Protection offered by these flood walls is assumed to be 1 in 100 (1%) AEP 
throughout the appraisal period including the effects of climate change. The alignment of the 
walls and their dimensions are an estimate. If this option is taken forward, these will have to be 
assessed and optimised at that stage. The design of the flood walls must be made to fit 
visually into the surrounding area. 

More detailed assessment of this option would need to investigate the industrial estate to 
identify the business types in more detail to give estimates of the damages and benefits in this 
area. This would also allow any potential partnership funding opportunities to be identified. As 
with Option 1 the required height of wall would need to be assessed with modelling and 
technical feasibility investigated in more detail. 

Option 3 - Reinstate Historical Mill Race as overfl ow channel 

There is a historical mill race within the study area opposite the properties at risk. This channel 
has been blocked by the land owner and currently does not take any flow. This mill race could 
be reinstated and used as an overflow channel reducing flow in the main channel during flood 
events. 

The channel is relatively small and would not have significantly affected flood depths during 
the 2015 Boxing Day event. However, the properties close to the river are at risk from minor 
events and this channel may reduce this risk. At this stage the assumption is made that this 
option would only benefit properties within the Very Significant risk band. 

This will also have a benefit for properties at risk of surface water flooding. As this option will 
lower the river level the drainage network will be more able to discharge when there is a large 
river flow. 

This would require engagement with the current landowner. There would also be additional 
maintenance associated with the new channel. 
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The benefits of this channel would need to be estimated in more detail in a more detailed 
assessment. Hydraulic modelling of the channel would be required to determine the amount 
that this channel would lower river levels in the main channel. 

Option 4 - Raise outfall level of surface water dra inage 

Raising the outfall of the surface water drainage system would allow surface water to drain 
during high river levels. This will reduce the risk of surface water backing up and causing 
flooding during high river levels.  

This outfall is currently owned and operated by Bradford MDC. Work was recently undertaken 
to raise the level of this outfall however these is still a risk of flooding and it is thought to be 
technically possible to raise the outfall further. It is assumed that pumps would not be required 
for the drainage system. Raising this outfall may have impacts on the drainage system further 
upstream, this has not been considered in the costs for this initial assessment. 

This will not reduce the risk of fluvial flooding but evidence suggests that there is currently a 
high risk of surface water flooding. This would not have prevented the flooding caused by the 
Boxing Day 2015 event. 

The current drainage network would need to be assessed to ensure that this option is feasible. 
The effects of raising this outfall on the drainage of nearby properties would need to be 
assessed to ensure this did not increase flood risk. 

Option 5 - Property Level Protection 

This option is to offer property level protection (PLP) to the 10 ground floor residential 
properties identified as being at Very Significant risk of flooding. PLP can take the form of 
barriers in doorways, non-return valves fitted to drains, and airbrick/vent covers. Properties 
can also be made more flood resilient, using waterproof plaster, solid concrete floors or tiled 
floor coverings in order to reduce the amount of time and money needed to recover from a 
flood event.  

Several properties within the area have already implemented property level protection to some 
extent. 

Advantages of this option include the fact that defences have minimal visual and land impact, 
and do not remove any of the flood plain area. PLP will protect against surface water as well 
as fluvial flooding. Any changes would need to be in keeping with the surroundings. 

Disadvantages of this option include the requirement for residents to receive sufficient warning 
and for them to be available and trained in deploying PLP measures. Furthermore, PLP does 
not provide any wider environmental benefits and does not prevent the flooding of areas 
surrounding the property. 

PLP is also only possible for properties in the Very Significant risk bank (based on NaFRA), 
and where flooding is less than 500mm deep. This option would not have prevented flooding 
of the scale experienced on Boxing Day 2015. The effectiveness of PLP reduces with long 
duration floods due to seepage. Deliverability of this option is reliant on the residents up take 
of PLP.  

More detailed assessment of this option would require information on the current extent of PLP 
within the area. Depths of flooding would also be needed to assess the benefits of PLP and 
what standard of protection this could offer. 
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1.4.2 Costs of options 

The costs for the options were calculated using the Environment Agency’s Project Cost Tool 
and Long Term Costing Workbook. The maintenance and operation costs relate to mechanical 
maintenance of the assets to Target Condition 3. Land purchase costs for Option 3 are based 
on an estimate of £10,000 per acre of land purchased. 

It is assumed that a major refurbishment of assets will be required at some point during the 
appraisal period after the initial construction phase. The timing of these replacements is based 
on the EA’s Asset Deterioration Guidance (2013), and the assumptions are outlined in 
Appendix C.  

An appraisal period of 100 years has been used. A detailed breakdown of costs across this 
period is included in Appendix C. 

Table 1.2 shows the build-up of costs for all options.  

Table 1.2 Initial Project costs and ongoing maintenance (£k) 

Item 

Option 1 
Flood Wall 

along 
Riverbank 

at 
Castlefields 

Lane 

Option 2 
Flood Wall 

for 
Castlefields 

Lane and 
properties 

at 
industrial 

estate  

Option 3 
Mill Race 
Bypass 

Option 4 
Raised 
Outfall 

Option 5 
PLP 

Construction Costs 280.2 965.6 100.8 50.4 65.8 

Environment Agency staff 44.3 152.6 15.9 8.0 10.4 

Consultant fees (appraisal) 17.9 61.8 6.5 3.2 4.2 

Consultant fees (design) 60.8 209.1 21.9 10.9 14.3 
Consultant fees 
(construction) 

15.7 
54.1 

5.6 2.8 3.7 

Site investigation & survey 4.2 13.5 1.5 0.8 1.0 

Land Purchase 0.3 4.8 25.9 0.1 0.1 

Optimism Bias 186.3 643.7 67.0 33.5 43.8 

TOTAL  609.8 2106.6 245.1 109.6 143.2 

Annual Operation and 
Maintenance Costs 

0.67 1.02 0.76 0.65 0.65 

1.5 Initial environmental assessment 

The main impacts of each option are summarised in Table 1.3. 
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Table 1.3 Key environmental impacts, mitigation and opportunities 

Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Option 1 Flood Wall along riverbank at Castlefields  Lane 

Reduced risk of flooding 

Visual impact of wall 
Construction work alongside 
watercourse. Risk of pollution 
incidents and disruption to area 
during construction 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance 

Option 2 Flood Wall for Castlefields Lane and prope rties at industrial estate  

Reduced risk of flooding 

Visual impact of wall 
 
Construction work alongside 
watercourse. Risk of pollution 
incidents and disruption to area 
during construction 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance 

Option 3 Mill Race Bypass  
Reduced risk of flooding 
 
Additional length of channel 
with associated ecological 
benefits 
 

Loss of land between Mill Race 
and River 

Early engagement with landowners 
recommended to enhance 
opportunities and minimise 
negative impacts 

Option 4 Raised Outfall  
Reduced risk of surface water 
flooding if technically feasible   

Option 5 PLP  

Reduced risk of flooding 
Flood protection measures may 
be limited for listed buildings in 
area 

 

1.6 Consultation 

The options in this appraisal were developed in consultation with the Environment Agency and 
Bradford MDC. No public consultations were held at this stage as the work is a high-level 
assessment of potential options. Stakeholder engagement will take place at subsequent 
stages of the project. 

1.7 Economic summary and preliminary preferred option 

Table 1.4 summarises the economic assessment carried out for all options. The calculations 
for PV benefits area shown in Appendix E. The options are ordered by benefit (lowest benefit 
first). 

This benefit values are estimates based on the methodology detailed in Appendix D. There is 
significant uncertainty in these estimates, which are based on Weighted Annual Average Data 
(WAAD) from the Multi-Coloured Manual (MCM, 2015/16). If this project progresses to further 
appraisal the benefits of these options should be more accurately assessed though hydraulic 
modelling and use of the more detailed flood depth/damage data from MCM.  
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Table 1.4 Benefit-cost assessment  

 PV costs  
(£k) 

PV 
benefits  

(£k) 

Av. 
BCR 

Incr’ 
BCR 

Option for iBCR 
calc  Comments 

Do Nothing       

Do Minimum 16.9 72.5 4.3   
High ABCR but 

properties remain at 
Very Significant risk 

Option 4 -  Raised 
Outfall 

128.5 442.0 3.44 3.31 Do Minimum 
Highest ABCR and 

IBCR of Do Something 
Options 

Option 5 - PLP 302.9 517.0 1.17 0.43 Option 4 

PV Benefits highly 
uncertain as depends 

on reliability of 
deployment and 

technical suitability 

Option 3 – Mill 
Race Bypass  

265.3 700.1 2.64 2.89 Option 4 

Higher benefit at lower 
cost than option 5. 
High ABCR and 
protects against 
Fluvial flooding 

Option 1 – Flood 
Wall along 
riverbank 

610.4 908.0 1.49 0.60 Option 3 

Provides greater 
protection against 

overtopping but IBCR 
below parity compared 

to option 3 

Option 2 – Direct 
defences around 
industrial estate 

2176.5 4438.0 2.04 2.25 Option 1 

Positive ABCR and 
IBCR. Provides 

greater benefits than 
other options. Possibly 

greater potential for 
Partnership Funding 

The Do Minimum scenario has the highest average BCR justifying the continuation of the 
current maintenance regime. However, properties in the study area will remain at Very 
Significant risk in this scenario. 

Options 3 and 4, reinstatement of the mill race as a bypass channel and raising of the surface 
water outfall both have high benefit-cost ratios. These options have high benefits through 
reducing damage from high frequency incidents. Neither of these options will prevent flooding 
in large flood incidents such as the Boxing Day flooding and properties will remain at some 
risk, so it is possible the benefits are overstated.  

Option 2, defending the industrial estate and residential properties, also has high BCR 
although at a significantly higher cost than other options. This benefits the Non-Residential 
properties in the industrial estate that are also at risk from high frequency events. There may 
also be greater potential for partnership funding for this option due to the properties in the 
industrial estate benefiting from the scheme. 

Preliminary estimates for Partnership Funding scores for Options 2, 3 and 4 have been 
calculated as shown in Table 1.5. 

The benefit period for the bypass channel is 100 years as no further major investments will be 
required. The benefit period for the raised outfall and defence structures is 90 years as beyond 
this a further investment will be required to replace the outfall structure or defence walls. For 
PLP the benefit period is 20 years as after this the PLP measures will require replacement. 
The details of this calculation and sensitivity testing are including in Appendix F. 
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Table 1.5 Benefit-cost ratios and outcome measures  

Contributions to outcome measures  

Option 1 – 
Flood Wall 
along 
riverbank  

Option 2 – 
Direct 
defences 
around 
industrial 
estate 

Option 3 – Mill 
Race Bypass 

OM1 – Economic Benefit:     

    Benefit period used for Partnership 
Funding calcs 90 90 100 

    PV Benefits (£) 890,229 4,351,172 700,066 
    PV Costs (£) 626,229 2,136,438 265,259 
    Benefit/Cost ratio 1.42 2.04 2.92 
OM2 – No. of households moved out of any 
flood probability category to a lower category 

10 10 10 

OM2b – No. of households for which the 
probability of flooding or coastal erosion is 
reduced from the very significant or 
significant category to the moderate or low 
category 

0 0 0 

OM2c – No. of households in the 20% most 
deprived areas moved from the very 
significant or significant flood probability 
category to the moderate or low category  

0 0 0 

OM3 – No. of households better protected 
from coastal erosion 

0 0 0 

OM3b – No. of households protected against 
loss in 20 years from coastal erosion 

0 0 0 

OM3c – No. of households in the 20% most 
deprived areas protected against loss in 20 
years from coastal erosion 

0 0 0 

OM4a – Hectares of water dependent 
habitat created or improved to help meet the 
objectives of the Water Framework Directive 

0 0 0 

OM4b – Hectares of intertidal habitat 
created to help meet the objectives of the 
Water Framework Directive for areas 
protected under the EU Habitats/Birds 
Directive  

0 0 0 

OM4c – Kilometres of rivers protected under 
the EU Habitats/Birds Directive improved to 
help meet the objectives of the Water 
Framework Directive 

0 0 0 

Partnership Funding (PF) Score  16% 14% 30% 

Contributions required for a PF score of 
100% 

£526,665 £1,843,930 £168,168 

Contributions required for a PF score of 
120% 

£543,022 £1,891,662 £179,795 

 

Contributions to outcome measures  Option 4 – 
Raised Outfall 

Option 5 – 
Property Level 
Protection 

OM1 – Economic Benefit:    

    Benefit period used for Partnership 
Funding calcs 

90 20 

    PV Benefits (£) 477,269 241,750 

    PV Costs (£) 126,085 154,515 

    Benefit/Cost ratio 3.44 1.56 
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Contributions to outcome measures  Option 4 – 
Raised Outfall 

Option 5 – 
Property Level 
Protection 

OM2 – No. of households moved out of any 
flood probability category to a lower category 

8 10 

OM2b – No. of households for which the 
probability of flooding or coastal erosion is 
reduced from the very significant or 
significant category to the moderate or low 
category 

0 0 

OM2c – No. of households in the 20% most 
deprived areas moved from the very 
significant or significant flood probability 
category to the moderate or low category  

0 0 

OM3 – No. of households better protected 
from coastal erosion 

0 0 

OM3b – No. of households protected against 
loss in 20 years from coastal erosion 

0 0 

OM3c – No. of households in the 20% most 
deprived areas protected against loss in 20 
years from coastal erosion 

0 0 

OM4a – Hectares of water dependent 
habitat created or improved to help meet the 
objectives of the Water Framework Directive 

0 0 

OM4b – Hectares of intertidal habitat 
created to help meet the objectives of the 
Water Framework Directive for areas 
protected under the EU Habitats/Birds 
Directive  

0 0 

OM4c – Kilometres of rivers protected under 
the EU Habitats/Birds Directive improved to 
help meet the objectives of the Water 
Framework Directive 

0 0 

Partnership Funding (PF) Score  39% 19% 

Contributions required for a PF score of 
100% 

£76,623 £124,604 

Contributions required for a PF score of 
120% 

£84,695 £129,486 

 
Option 2 has the lowest PF score and would require significant contributions to proceed. This 
option is considered less viable than Options 3 and 4 due its high cost. The preferred options 
from this appraisal are therefore Options 3 and 4. 

Neither of these options fully addresses the risk of flooding from overtopping of the bank. Option 
4 only addresses surface water flooding and not fluvial flooding. Option 3 will only have a benefit 
during minor events. 

1.7.1 Limitations and Uncertainties 
This initial assessment has produced a high-level appraisal of options available to manage flood 
risk at Castlefields Lane. There are limitations to the methodology applied and more robust 
appraisal would be required to have greater confidence in the results.  

Costs for options are based on the EA Project Costing Tool. These costs will need to be reviewed 
in more detail for any future appraisal work.  

The Weighted Annual Average Damages (WAAD) from the Multi-coloured Manual have been 
used to assess damages and hence benefits. This assesses damages based on the number of 
properties affected. This does not take into account the depths of flooding and more accurate 
damages could be calculated if this information on expected flood depths was available. 

The WAAD methodology is unsuitable for assessing the impacts of climate change. Defences 
have been assessed as provided a constant standard of protection throughout the appraisal 
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period. Options accounting for future climate change will provide a higher standard of protection 
early in the appraisal period.  

There is uncertainty of the risk of surface water flooding and the potential benefits options would 
have in reducing this. Properties at risk have been estimated based on LIDAR data and the risk 
of surface water flooding within the study area should be investigated in more detail. 
 
1.7.2 Funding and contributions 

A funding analysis tool was used to identify potential direct and indirect beneficiaries of the 
scheme. This is included in Appendix F. Based on these beneficiaries potential funding 
sources identified include: 

• Local Authority Funding 

• Community Infrastructure Levy 

• Council Tax 

• Benefitting Local Businesses (Option 2 only) 

1.7.3 Key delivery risks (economic, social and environmen tal) 

Key delivery risk and recommendations for mitigating these risks are shown in Table 1.6. 

Table 1.6 Risks and mitigation  

Risk Key Mitigation 
Bypass channel does not reduce flood levels to 
a sufficient extent to protect properties 

Modelling of this option should be carried 
out to assess its impact on flood flows 

Insufficient 3rd party Funding available to allow 
scheme to progress 

Assess potential funding options before 
progressing scheme appraisal further. 

Inaccurate benefits assessment due to 
limitations of approach to economic damage 
calculations used for IA 

A more accurate damages assessment 
based on hydraulic modelling and flood 
depth damage data should be considered 
before progressing to further appraisal. 
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1.8 Project Scoring 

The data used in this assessment has been subjected to a RAG assessment. The RAG score 
assesses the project against the categories shown below. This gives a three figure score with the 
first number being the number of reds, where there is significant uncertainty or challenges. The 
second and third numbers are the numbers of amber(defined as needs development, but is 
manageable) and green(well defined, not likely to be an issue) scores. The results are shown 
below: 

• A – Problem Definition: The fluvial flooding is well defined with flood outlines but 
further investigations required to understand the surface water flooding mechanisms – 
AMBER  

• B – Economic: There are limitations to the methodology applied and more robust 
appraisal would be required to have greater confidence – RED: 

• C – Funding:  The options are likely to require external funding. Potential funding 
sources have been identified – AMBER  

• D – Engineering case: Preferred solutions are tried and tested defence options – 
AMBER  

• E – Permissions & Consents: Solutions are unlikely to require unusual permissions or 
consents – GREEN 

• F – Environmental sensitivities: Initial environmental assessments has been 
completed based on outline options, some impact from options requiring work close to 
river – AMBER  

• G – Opportunities: Some potential opportunities for partnership working – AMBER  

Model 

A 

Economic 

B 

Funding 

C 

Eng. 

D 

Permissions 

E 

Env. 

F 
RAG 

Opps. 

G 

2 3 2 2 1 2 141 2 

 

1.9 Further work requirements 

If the project is taken forward for further appraisal it is recommended that the effects of the 
bypass are modelled to assess what benefits this channel will have and how much damage is 
avoided from more frequent events. Similarly the effect of raising the outfall should be 
assessed in detail to determine the reduction in risk that can be achieved from this.  

The condition of the mill race channel will need to be assessed to determine the work required 
to reinstate this. The structure associated with this channel is reported to have collapsed and 
this may increase the costs associated with its reinstatement.  

More accurate information on flood depths at the properties for different annual flood 
probabilities are required in order to more accurately estimate economic damages and to 
confirm or rule out the viability of the PLP option. Table 1.7 outlines key dates if these options 
are taken forward for further appraisal. 

A culvert was identified on the left bank of the River Aire close to Castlefield Industrial Estate. 
The ownership and route of this culvert is currently not known. This would need to be 
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inspected prior to any works taking place in order to understand if it influences flood risk in the 
area. 
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Neither of the preferred options prevent flooding to the area from larger flood incidents. 
Options providing higher standards of protection were seen to be less viable.  

It is recommended to consider this area within larger appraisal projects. The flood storage 
areas investigated in the Upper Aire SFRA are being considered in Leeds FAS phase 2 would 
benefit Castlefields Lane as well as other properties close to the Aire at high risk where local 
schemes may be less beneficial. The Marley Bridge site is of particular benefit to Castlefields 
Lane due to its close proximity upstream of the site. 

1.10 Conclusions and Recommendation 

• Properties at Castlefields Lane and the adjacent Castlefield Industrial Estate are at 
high risk of flooding from the River Aire. The main risk of flooding is fluvial from the 
River Aire overtopping its banks. There is also a risk of surface water flooding 
particularly when the surface water drainage is unable to discharge into the river. 
There was significant flooding in the area during Boxing Day 2015. 

• Due to the high risk of flooding in this area solutions providing a relatively low standard 
of protection have high benefits and can be shown to be economically viable. Option 
3, creating a bypass channel, is a viable solution for managing flood risk and could be 
taken forward for further appraisal. This will reduce risk from both fluvial flooding and 
surface water flooding. Option 4, raising the surface water outfall will reduce the risk of 
surface water flooding to the area. 

• Properties remain at high risk of flooding with both these options and these options 
would not have significantly reduced flooding to the area during the Boxing Day 2015 
incident. Options that provide a higher standard of protection are less viable due to 
their higher costs.  

• Previous assessment work has considered options for large-scale flood storage on the 
River Aire at Holden Park and Marley Bridge upstream of the study area. These would 
reduce flood risk to Castlefields Lane as well as to other areas along the River Aire. 
The predicted 0.89m reduction in flood levels from this storage would reduce the need 
for direct defences at the study area. This would also increase the effectiveness of 
PLP and other options. 

• These online storage areas on the Aire may present a viable solution to providing a 
higher standard of protection to Castlefields Lane and it is recommended that this FSA 
is assessed further. Appraisal of these storage areas should consider benefits to 
Castlefields Lane as well as the wider Aire catchment including Leeds and other sites 
in Bradford.  
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Appendices 


